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Document Conventions

DescriptionConvention

Identifies elements on a screen.Bold

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Monospace font

Identifies:Italic

Variables for which you must supply values specific to your own situation or
environment.
New terms the first time they occur in the text.
References to other documentation sources.

Identifies:Monospace font

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

{ }

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

|

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

[ ]

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

...

Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://documenta-
tion.softwareag.com.

In addition, you can also access the cloud product documentation via https://www.software-
ag.cloud. Navigate to the desired product and then, depending on your solution, go to “Developer
Center”, “User Center” or “Documentation”.

Product Training

You can find helpful product training material on our Learning Portal at https://knowledge.soft-
wareag.com.
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Tech Community

You can collaborate with Software AG experts on our Tech Community website at https://tech-
community.softwareag.com. From here you can, for example:

■ Browse through our vast knowledge base.
■ Ask questions and find answers in our discussion forums.
■ Get the latest Software AG news and announcements.
■ Explore our communities.
■ Go to our public GitHub and Docker repositories at https://github.com/softwareag and ht-
tps://hub.docker.com/publishers/softwareag and discover additional Software AG resources.

Product Support

Support for Software AG products is provided to licensed customers via our Empower Portal at
https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

■ Download products, updates and fixes.
■ Search the Knowledge Center for technical information and tips.
■ Subscribe to early warnings and critical alerts.
■ Open and update support incidents.
■ Add product feature requests.

Data Protection

SoftwareAGproducts provide functionalitywith respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.
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What is ApplinX?

ApplinX is a server-based technology that provides web-based applications an efficient, robust
and easy way to access and integrate core system applications' data and transactions, without
changing the core systems.

ApplinX exposes core systems and encapsulates them into standard programmatic components
of the new selected environment (web services, .NET, J2EE, XML). These components can then be
used as advanced building blocks in any modern platform - for new applications or existing ones
(e.g. CRM applications). This way, core back-office systems can be integrated into new strategic
IT platforms, and the workflow can be re-engineered to suit a more streamlined and efficient task-
oriented and role-based approach.
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SOA Enablement

SOA enablement allows reuse of functionality of the core systems, leveraging the operational
qualities of the systems' transaction platform to new IT projects. This is accomplished by exposing
the core systems' functionality and data as web services - either at the screen or transaction level
- and integrating with any other environments that invoke web services. It also enables the core
systems to become active equal peer participants in an SOA world.

Refer to Installing ApplinX Demo Applications. Also refer to the self-training material available
on the Software AG Empower website.

Refer to SOA Enablement in the ApplinX Solutions documentation for further details as how to use
this solution.
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Web Enablement

Pure HTML Emulation

ApplinX HTML emulation is an out of the box thin client HTML emulation, available in the .NET
and J2EE environments. The screenshot belowdisplays a host screen inApplinXHTMLemulation
in the browser.

ApplinX is able to turn an existing terminal emulation instantly into a web browser terminal
emulation, providing host key and print support and maintaining existing color schemes. This
does not require any training for end users and can easily replace locally installed terminal emu-
lation software with the thin-client web browser.

Refer to Installing ApplinX Demo Applications. Also refer to the self-training material available
on the Software AG Empower website.

Refer toWeb Enablement - Pure HTMLEmulation in theApplinX Solutionsdocumentation for further
details as how to use this solution.

Getting Started8
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Instant Web Application

The instantweb application allowsmodernization of core system applications intomodern looking
web applications with (little or) no coding. Simple web configurations can improve the general
"Look & Feel" of the application: designing a template with top and side images and a "company
logo" (Inventory System), modifying the style sheet using different fonts, colors, etc. End users
get the information quicker and with improved visibility. Also new users can be trained more
easily (web-like usage).

Using Screen Groups, the same design can be globally applied to multiple screens. Using Trans-
formations, host patterns can be converted to web components. Such transformations include:
formatting the screen's header area, formatting the message line, formatting titles and borders,
converting input fields into GUI elements (combo boxes, radio buttons, check boxes), adding a
calendar component to date input fields, formatting the host function keys into hyperlinks, buttons
or images and removing unnecessary characters.

Refer to Installing ApplinX Demo Applications. Also refer to the self-training material available
on the Software AG Empower website.

Refer toWeb Enablement - InstantWeb Application in theApplinX Solutionsdocumentation for further
details as how to use this solution.

9Getting Started
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Composite Web Application

Using the composite web application it is possible to fully customize and extend your web applic-
ations using your Java or .NETdevelopment environment. The compositeweb application enables
aggregating information from many core systems into one web page. It is possible to integrate
legacy assets on various levels (screen, transaction, data), support various web environments
making use of the ApplinX Base Objects (API) and customizing web frameworks.

Refer to Installing ApplinX Demo Applications. Also refer to the self-training material available
on the Software AG Empower website.

Refer toWeb Enablement - Composite Web Application in the ApplinX Solutions documentation for
further details as how to use this solution.
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Lists the recommended hardware and software requirements for the variousApplinX components.

Hardware Requirements

■ Server
■ ApplinX Development Workstation
■ Network

Server

■ 2 x 3 GHz Intel(R) Xenon(TM) processors (for 500 concurrent users).
■ 2GB free disk space.
■ RAM: ApplinX Server requires 200 MB. Each application requires additional minimum 40 MB
(depending on the application repository size). Host sessions require 1MB per session.

■ Network card.

ApplinX Development Workstation

■ 2GB free disk space (server and development tools).
■ RAM: minimum 4GB.
■ Network card.

Network

ApplinX supports working with IPv6 as well as IPv4 when working with ApplinX components
that use IP addresses.

Software Requirements

■ Operating Systems and Supported Platforms
■ ApplinX Repository
■ ApplinX for JSP Web Application
■ ApplinX .NET Web Application

Getting Started12
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■ Supported Browsers

Operating Systems and Supported Platforms

For details regarding supported platforms, refer to theRelease Notes. For themost updated inform-
ation refer to the Software AG Empower website at https://empower.softwareag.com.

ApplinX now fully supports Java Version 11 (runtime and compile time). ApplinX can run inde-
pendently as an independent Java process (this is the default Windows/Linux installation), or as
a J2EE application under one of the following application servers:

■ Apache Tomcat 8.5, 9
■ Oracle WebLogic 12.1.3
■ WildFly 23.0.1 / JBoss EAP 7.3
■ Microsoft IIS 7.5, 8, 8.5, 10
■ WebSphere 9.0.x

When running ApplinX as a J2EE application, the ApplinX server needs to be deployed with the
Deployment Manager for J2EE (refer toDeploying with ApplinX in the Designing and Developing an
Application documentation. It is possible to run ApplinX as a standalone server.

ApplinX Repository

ApplinX uses an internal database as a repository, based on the H2 database. External databases
used as repository are no longer supported and will be migrated to the internal DB configuration.
If you are using the JDBC/ODBC bridge, you will need to migrate manually. SeeMigration of
ApplinX Applications with External Database.

ApplinX for JSP Web Application

Developer's station:

■ JDK 11
■ Apache Tomcat 8.5, 9
■ JSP IDE - we recommend using the latest version of Software AG Designer (based on Eclipse
4.19)

Server:

■ JDK 1.8
■ One of the following application servers:

■ Apache Tomcat 8.5, 9
■ WebLogic 12.1.3

13Getting Started
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■ WebSphere 9.0.x
■ WildFly 23.0.1 / JBoss EAP 7.3

ApplinX .NET Web Application

Developer's station:

■ Microsoft IIS 7.5, 8, 8.5, 10
■ Visual Studio 2017, 2019
■ Microsoft Visual J# .NET Version 2.0 Redistributable Package - Second edition

Server:

■ Microsoft IIS 7.5, 8, 8.5, 10
■ Microsoft .NET Framework Version 2.0, 3.0, 3.5, 4.0, 4.6 Redistributable Package
■ Microsoft Visual J# .NET Version 2.0 Redistributable Package - Second edition

Note: When creating an ApplinX .NET web application, view state is turned off by default
(web.config file). If you want to use Net web controls in generated pages, ensure that you
activate this option. Refer to the Microsoft ASP.NET documentation for further details.

Supported Browsers

■ Microsoft Internet Explorer 11, Edge
■ Mozilla Firefox: latest version provided by vendor when this version of ApplinX was released
■ Google Chrome: latest version provided by vendor when this version of ApplinX was released
■ Safari: latest version provided by vendor when this version of ApplinX was released

Getting Started14
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Installation

For greater security, default password handling has been enhanced for Software AG products that
are installedwith the SAG Installer. On theAdministrator Password panel, enter a default product
administrator password for the products you are installing, and choose whether to require the
password to be changed on first product login. SeeDefining Passwords in the ApplinXAdministra-
tion documentation for details.

Note: If you aremigrating from a previous install base, the password of this previous version
applies, regardless ofwhat you specify in theAdministrator Passwordpanel.We recommend
you change this password as soon as possible.

We recommend you always install the latest fixes available for your products. These are available
from the Empower Product Support website.

See also Setting Environment Variables under Linux.

ApplinX License Keys

■ About ApplinX Licenses
■ License Key Expiration
■ Multiple License Key Handling
■ Updating Your License
■ License Metering using Command Central

Note: During the installation process, a check is performed that the license is of the same
version as the installed ApplinX server. The license key format from version 9.6 and earlier
is no longer supported. If you are logged on to SoftwareAG's Empower site, you can request
a new license key from Software AG Logistic Service Center (LSC).

About ApplinX Licenses

ApplinX can be purchased with one of the following types of licenses (it is possible to purchase
more than one type of license):

■ SOA license: Used for SOA enablement, including host transactions (RPC connections) and
direct database access, and for web page integration solutions. From ApplinX 9.12, licenses are
calculated based on number of connections or number of cores.

■ Web enablement license: Used for HTML emulation, instant web application and for composite
web application. Printer connections are also counted as web enablement connections.

The table below shows the possible combinations of web and SOA licenses:
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Notes
Web

Enablement
SOA

Scenario Core-basedConnection-based

Only one connection-based license
possible per server

XSOA connection-based
license only

License is calculated on number of
cores. Only one core-based license
possible per server.

XSOA Core-based license
only

Printer connections are also counted
as Web enablement connections.

XWeb enablement license
only

SOA core-based license not possible
in this combination.

XXSOA connection-based and
Web enablement

SOA connection-based license not
possible in this combination.

XXSOA core-based and Web
enablement

The ApplinX license is purchased for a number of users for each type of license. For example, you
can purchase a license for 100 SOA users, and another license file for 50 web enablement users.
When connecting to a session, the number of opened connections is compared with the number
of users defined in the license file. The number of possible users must be equal to or greater than
the number of opened connections.When trying to connectwith an additional user, youwill receive
the following error message: Cannot connect session. The server has reached the full
capacity of concurrent users.

Notes:

1. When working with a Connection Pool entity, connections will be related to a specific license
type only once they are in use within a specific solution (SOA or web enablement).

2. A session used by a developer within the Designer is not counted as a connection.

3. Once the expiration date defined in a license file is reached, the connections count defined in
the file is dropped from the accumulated connection count (per type).

4. License keys from version 9.6 and earlier are no longer supported. The following usermessages
appears when the server starts if in the license directory there is an old license: License key
format from version 9.6 and earlier is no longer supported. You can request a new
license key from Software AG Logistic Service Center (LSC). STOPPING SERVER...
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License Key Expiration

For ApplinX licenses of type subscription or test, a daily message in server log will appear if there
are less than 60 days to expiration date.

Multiple License Key Handling

If you received more than one ApplinX license key from Software AG Logistics and you want to
use the functionality of multiple licenses on one ApplinX server instance (for example SOA En-
ablement and HTML Emulation), follow the steps below:

To use multiple license keys

1 Install ApplinX by using one of the provided license keys.

2 Before you start ApplinX server, manually copy all other provided ApplinX license keys to
directory <Software AG Installation>\common\conf.

When you restart your ApplinX server, the total number of licensed connections for all provided
license keys will be available to this ApplinX server instance.

Updating Your License

If you wish to change the license key after the installation, you need to locate the license file
(<Software AG Installation>\common\conf) and replace the old license with the new one. Restart
ApplinX server and the Designer.

License Metering using Command Central

ApplinX now supports the licensemetering functionality provided byCommandCentral. License
metering depends on license manifest files. Each license manifest file issued by Software AG
contains all contracts for one location of your organization. If you received license manifest files
from Software AG, you can generate or view a report of the current state of your landscape. For
details see Creating and Viewing License Metering Reports in the Command Central Online Help.

Note: This functionality is provided for single-license landscapes only. Multiple licenses
are not supported.
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This document describes how to build an ApplinX Docker image and run the Docker container
using scripts provided with ApplinX. It covers the following topics:

See also High Availability with Container Orchestration in the Administration documentation.

Prerequisites

■ Docker installation 1.13.1 or compatible.
■ SoftwareAGApplinX installation. Theminimumrequirement isApplinX Server and Framework
for JSP.

Building and Running the ApplinX Docker Image

The scripts providedwithApplinX support the following twomethods of building aDocker image
and running the Docker container.

■ Using a Modified Configuration
■ Using a Customer Application File (GXAR File)
■ General Notes

Using a Modified Configuration

In this option a configuration file is used to define properties to connect to the host. You can set
these properties in a Docker build command or in a Docker run as follows:

To use modified configuration files in the Docker build

1 Set your working directory to <install_dir>/ApplinX/Docker.

2 Create the TAR file containing all the necessary files with the following command:

./createApplinXDistributions.sh

3 Provide your License file and put it in your license folder: <install_dir>/ApplinX/Docker/li-
cense/myLicense.xml.

4 Update gx_updateAppConfig.xml file in folder <install_dir>/ApplinX/Docker/configuration
with the properties to connect to the host.

5 Build the ApplinX image with --build-arg USE_CONFIG_FILE=true, for example:
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docker build --build-arg USE_CONFIG_FILE=true -t [Image Name] .

With this method, the Docker build copies the configuration into the image; this file will be
used to set the configuration of the ApplinX application. You thenwill need tomap ports and
set the credentials to connect to the ApplinX server. For example:

docker run -p 8080:8080 -p 2323:2323 --env USERNAME=<ApplinX server user> ↩
--env PASSWORD=<ApplinX server password> [Image Name] .

■ Advantages
Configuration changes can be persistent; you can reuse the configuration when a new version
or fix is to be built. The complete configuration is in the image. For troubleshooting, Software
AG Support will require only the image and the command you entered.

■ Disadvantage
If the configuration changes, you will need to build a new image and rerun the container.

To use modified configuration files in the Docker run

1 Set your working directory to <install_dir>/ApplinX/Docker.

2 Create the TAR file containing all the necessary files with the following command:

./createApplinXDistributions.sh

3 Provide your License file and put it in your license folder: <install_dir>/ApplinX/Docker/li-
cense/myLicense.xml.

4 Build the ApplinX image with, for example:

docker build -t [Image Name] .

5 Add to the docker run the USE_CONFIG_FILE=true property and specify the location of the
configuration file (gx_updateAppConfig.xml) with -v prefix as follows:

docker run -v <local machine configuration folder>:/config -p 8080:8080  -p ↩
2323:2323  --env USERNAME=<ApplinX server user> --env PASSWORD=<ApplinX server ↩
password> --env USE_CONFIG_FILE=true [Image Name]

■ Advantages
You can set for each container (instance of the image ) the specific configuration to connect to
host.
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Using a Customer Application File (GXAR File)

Note: This is the correctway to create a completeDocker imagewith theApplinX application.
You can set properties in a Docker build command or in a Docker run as follows:

To use customer application file using a Docker build

1 Set your working directory to <install_dir>/ApplinX/Docker.

2 Create the TAR file containing all the necessary files with the following command:

./createApplinXDistributions.sh

3 Provide your License file and put it in your license folder: <install_dir>/ApplinX/Docker/li-
cense/myLicense.xml.

4 Provide your application GXAR file and put it in the data folder: <install_dir>/ApplinX/Dock-
er/data/yourApplication.gxar.

5 Build the ApplinX image, for example:

docker build --build-arg GXAR_NAME_ARG=<yourApplication[.gxar]> -t [Image Name] .

With this method, the Docker build copies the application into the image. You will need to
map your ApplinX ports and set the credentials to connect to the ApplinX server during
startup, for example:

docker run -p 8080:8080 -p 2323:2323 --env USERNAME=<ApplinX server user> --env ↩
PASSWORD=<ApplinX server password> [Image Name]

■ Advantages
You can provide your application file; this file will be added to the image. For troubleshooting,
Software AG Support will require only the image and the command you entered.

■ Disadvantage
If you want to connect to another ApplinX application, you will need to build a new image and
rerun the container.

To use customer application file using a Docker run

1 Set your working directory to <install_dir>/ApplinX/Docker.

2 Create the TAR file containing all the necessary files with the following command:
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./createApplinXDistributions.sh

3 Provide your License file and put it in your license folder: <install_dir>/ApplinX/Docker/li-
cense/myLicense.xml.

4 Build the ApplinX image, for example:

docker build -t [Image Name] .

5 Add to the Docker run theApplinXGXARfile and its location (you also need tomap the open
ports and the ApplinX server credentials):

docker run -v <local location of gxar file>:/data --env GXAR_NAME_ARG=<the name ↩
of the gxar file>[.gxar] -p 8080:8080 -p 2323:2323 --env USERNAME=<ApplinX ↩
server user> --env PASSWORD=<ApplinX server password> [Image Name]

■ Advantages
You can set for each container (instance of the image) the specific ApplinX application to connect
to host.

General Notes

■ If the Docker container wasn't defined correctly and there is a need to make some changes in
the configuration, you can use an ApplinX Designer to connect to the ApplinX server through
the port defined to it (the default is 2323). Then you can open the ApplinX application andmake
the needed changes. Those changeswill be saved in the container and the containerwill become
functional.

■ In the Docker run you can also provide local license files and configuration files by mapping
them to the image specific folders as follows:

docker run -v <user_dir>/MyLicense:/license -v <user_dir>/MyConfig:/config -p ↩
8080:8080 -p 2323:2323 [Image Name]

■ You can change/add configuration files and they will be added to the image when you run the
Docker build:
■ <install_dir>/ApplinX/Docker/configuration/gx_updateAppConfig.xml
■ <install_dir>/ApplinX/Docker/configuration/gx_appConfig.xml
■ <install_dir>/ApplinX/Docker/configuration/gx_clientConfig.xml
■ <install_dir>/ApplinX/Docker/configuration/gx_keyboardMappings.xml

■ You can change the name of the imported ApplinX application by setting the APP_NAME_ARG
property (the default name is DockerApplication).

■ In theDocker run phase,we need to connect to theApplinX server in order to import theApplinX
application. For this you need to supply the ApplinX server credentials
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either in the Docker build phase:

docker build --build-arg USERNAME_ARG=<ApplinX server user> --build-arg ↩
PASSWORD_ARG=<ApplinX server password>

or in the Docker run:

docker run --env USERNAME=<ApplinX server user> --env PASSWORD=<ApplinX server ↩
password>

Verifying the Build

To verify the build

1 Show the image with command

docker images

2 Start the docker image to be verified as described above, for example:

docker run -d -p 8080:8080 -p 2380:2380 --name applinx_container_1 applinx_image_1

3 Show the log:

docker logs -f applinx_container_1

4 Show the containers:

docker ps

5 Stop the container:

docker stop applinx_container_1

6 Delete the container:
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docker rm applinx_container_1

7 Remove the image:

docker rmi applinx_image_1

Healthcheck for the ApplinX Docker Image

The docker directory contains a script healthcheck.sh. Execution of this script pings the APX
server and returns the result of the ping command:

success0
failure1

In theDocker context, this healthcheck.sh is put into theDocker container and enabled by setting
the HEALTHCHECK instruction in the Dockerfile.

You can also use the healthcheck.sh script in the context of an orchestration tool (e.g. Kubernetes)
to enable healthcheck functionality.

End-to-End Healthcheck for Natural for Linux and Clound

A typical installation of ApplinX connecting to Natural on a Linux host consists of the following:

■ Tomcat serving web page of the ApplinX Framework (or other web container such as JBoss,
WebSphere, WebLogic)

■ ApplinX server
■ ApplinX daemon that checks the authentication of users
■ Natural-APX executable
■ Adabas (or another database)

ApplinX provides an end-to-end healthcheck for Natural for Linux and Cloud that identifies the
point of failure. Two approaches are provided:

■ Command Line inside the Docker Container
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■ Healthcheck URL

Command Line inside the Docker Container

To perform an end-to-end healthcheck using the command line

■ Call the script /opt/softwareag/natuxhealthcheck.shwith the required parameters.

DescriptionOption

Show help for this utility--help

The ApplinX server url to connect to. By default applinx://localhost:2323-s <url>

Specify the username to connect to the host (as required by the Natural Open
System hosts)

-u <username>

Specify the password to connect to the host (as required by the Natural Open
System hosts)

-p <password>

ID of The Adabas DB that you wish to test-d <dbId>

Specify the ApplinX application to use for host connectivity information.-a <application>

The return value of the script indicates the end-to-end test result:

MeaningOutput Message
Response
Code

All five elements seem to be OK and
running.

OK.0

The Web Framework is not installed or
tomcat is not up.

The ApplinX web application is not available.-1

No connection to ApplinX server can be
established.

The ApplinX server is not available.-2

No connection possible between the
ApplinX server and the daemon.

The ApplinX daemon is not available.-3

the natapx binary is not installed / buffer
pool is full.

Natural is not available.-4

Adabas (or the back-end DB) is not
available.

Adabas is not available.-5

No username was specified.-6

An invalid DB ID was specified.-7

Invalid username or password.-8

The healthcheck functionality is supported with
Natural version 9.1.2 and above. To use this

-9

functionality, upgrade your Natural installation
accordingly.
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MeaningOutput Message
Response
Code

One of the parameters is missing.-10

Unexpected error.-11

Healthcheck URL

To perform an end-to-end healthcheck using a URL

■ Enter the following:

http://<host>:<port>/ApplinX/healthcheck?check_db=<db_id>&username=<username>&password=<password>

Provide appropriate values for host, port, DB ID, user and password.

The HTTP status indicates the result of the end-to-end test:

MeaningMessage
HTTP
Status

All five elements appear to be OK and running.OK.200

No username was specified.403

Invalid username or password

The Web Framework is not installed.The ApplinX web application is not available.404

No connection to applinx server can be
established.

The ApplinX server is not available.503

No connection possible between the ApplinX
server and the daemon.

The ApplinX daemon is not available.500

An invalid DB ID was specified.

Unexpected error.

The natapx binary is not installed / buffer pool
is full.

Natural is not available.501

Application misconfigured.

Adabas (or the back-end DB) is not avalable.Adabas is not available507
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6 Setting Environment Variables under Linux

If you installed ApplinX on a Linux system, source the Software AG environment file apxenv to
set the environment variable APPLINX_ROOT, or set the variable permanently by copying the settng
from the apxenv file into your profile. The apxenv file is located in the <Software AG_directory>/Ap-
plinX directory.
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Updating a Service Pack (from ApplinX Version 9.7 and above)

The upgrade process is similar to the installation process. Please refer to the SAG Installer docu-
mentation, which you can find at http://documentation.softwareag.com/. When selecting the in-
stallation directory, ensure not to select the directory where ApplinX is currently installed (the
default path is C:\SoftwareAG).

In the panel including the ApplinX specific parameters, browse and select the ApplinX license
file.

Post-update Results

■ When opening the Software AG Designer, the default workspace will point to a new location.
If you use the new workspace location, check that the preferences suit your needs.

■ From version 8.2, the batch and shell commands used to start and stop the server, and to start
the Administrator are located in the <ApplinX installation>/bin folder.

Post-update Tasks

■ When using ApplinX web applications (JSP or .NET): Upgrade the web application using the
ApplinX Web Application Manager in the Designer (refer to Framework Management in theWeb
Application Development documentation of ApplinX).

■ You may have made changes in your previous ApplinX version, in one of the following files.
Backup copies of these files can be found (unless otherwise stated) in the ApplinX installation
directorywith the .bak suffix. To apply these changes to your current ApplinX version, youmust
copy the changes from within the backup files to the relevant file.
■ GXApplinXService.ini
■ bin/startup.bat
■ bin/startup.sh
■ bin/gxadmin.bat
■ bin/gxadmin.sh
■ config/gxadmin.prp
■ config/gxstartup.prp
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Migrating

ApplinX applications from previous ApplinX versions are able to run on the current ApplinX
version once you have performed a number of migration activities. The migration process has
been tested for supported versions. Migration can be performedwhen installing the newApplinX
server version or via batch files after the new server has been installed.

The following topics are covered below:

■ Pre-Migration Steps and Prerequisites
■ Migration Options
■ Migration Results
■ Post-migration Tasks
■ Post-migration Web Application Tasks

Pre-Migration Steps and Prerequisites

■ Back up the repository database.

Migration Options

Migration can be carried out as follows:

■ Migration of all ApplinX Applications when installing ApplinX
■ Migration of all ApplinX applications after installing ApplinX
■ Migration of a Specific Applinx Application
■ Migration of ApplinX Applications with External Database

Migration of all ApplinX Applications when installing ApplinX

To migrate ApplinX applications during the installation process: In the screen where you select
the ApplinX parameters, select theMigrate previous ApplinX data check box and specify the
existing installation location.
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Migration of all ApplinX applications after installing ApplinX

To migrate all ApplinX applications after the installation has been completed: Run the <ApplinX
root>\utilities\migrate_ApplinX_server.bat/sh file, enter the installation path of your previous install-
ation, and then enter the new path of the current installation.

For example: migrate_ApplinX_server.bat "c:\ApplinX52" "c:\SoftwareAG\ApplinX"
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Migration of a Specific Applinx Application

To migrate a Single Applinx Application

1 Export the relevant GXAR file of the application (the GXAR file includes both the application
and entities)

2 Import theGXAR to the newversion. Refer to Importing anApplication's Configuration or Entities
in the Designing and Developing an Application documentation.

Migration of ApplinX Applications with External Database

For ApplinX applications that use an external database (except JDBC-ODBC), the database type
will be changed automatically to internal database. A message warns that there are applications
containing a JDBC-ODBC database type that will not be migrated. You have two options:

1. ChooseOK to continue with the installation. ApplinX will migrate all applications except for
the JDBC-ODBC types. The names of these applications will be written to a log.

2. Choose Cancel to stop the installation, then modify those applications.

To modify JDBC-ODBC applications

■ Change the repository type to internal DB /gxz in the original ApplinX installation installed
on your computer, and then restart the installation and migration.

Migration Results

The following is the outcome of themigration process and relates tomigrating all ApplinX applic-
ations:

■ The entire old config folder (except for the http.xml file) is copied to the new installation location.
The gxstartup.prp file from this folder is renamed to .bak, and the new gxstartup.prp file (from
the new installation) is used.

■ The new config folder (from the new installation) is renamed to config.bak.
■ The entire host-applications folder is copied except for the demo applications. The demo applica-
tions from the new installation are used.

■ All database related jar/zip (classes*.zip, classes*.jar, *sql*, *db2*) are copied to the lib folder of the
new installation. Note: any other DB driver should be copied manually to \ApplinX\applinx-
web\WEB-INF\lib.

■ The batch and shell commands used to start and stop the server, and to start the Administrator
are no longer located in the ApplinX installation folder. These files are now located in <ApplinX
installation>/bin folder and are named startup.bat and shutdown.bat accordingly for the server, and
gxadmin for the Administrator.
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The start-gxserver.bat/sh and gxadmin.bat/sh files from the previous ApplinX installation are
copied to <ApplinX Installation>\bin and the gxstartup.prp and GXApplinXService.ini files are
copied to <ApplinX Installation>. These files are renamed to *.bak.

Notes:

1. Anymanual changesmade in the previousApplinX versions (such as language, file encoding,
database jar etc.) must be backed up and copied to the new version.

2. Whenmigrating fromAPX 8.0, conf folder (internal Tomcat) is not copied from the old install-
ation. Therefore any manual change made in this folder must be re-done again in the new
conf folder.

Relevant for migrating from ApplinX versions before 8.0:

The following actions occur when the server is started for the first time after themigration process
has been completed:

■ Each application (configured in config/gxconfig.xml), will be created as a separate file and copied
to host-application/<application name>/gxconfig.xml. The original file config/gxconfig.xmlwill hold
from now on only ApplinX server configuration and host definitions which are not in use by
any application.

■ Replay files are copied to host-applications/<application name>/records and new recorded files are
saved in this location.

■ If a file based repository (GXZ orMDB) is configured for the application, the repository is copied
to host-applications/<application name>/db .

A post-migration report is written to the <ApplinX root>/log/gxlog.txt.

Note: If the application name includes space characters, these are replaced by underscores,
as space characters are not supported in versions from 8.0 and above. However, previous
SOAP clients will be able to connect to old addresses which include spaces.

Post-migration Tasks

■ When opening ApplinX Designer, enter the name of a workspace directory. When upgrading
from ApplinX version 8.0 and above, define a new workspace directory in order to be able to
work with both versions.
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Post-migration Web Application Tasks

JSP:

1. Ensure that you have:
■ SAG JDK
■ A supported web server (refer to ApplinX for JSP Web Application in the section Software
Requirements).

2. It is recommended to import/copy the web applications from older Eclipse versions to the
lastest version of the Software AG Designer, as this is the common Software AG development
tool, usedwith other SoftwareAGproducts such asApplinX, EntireX, CentraSite and Integration
Server.

3. Upgrade the web application using the ApplinX Web Application Manager in the Designer
(refer to Framework Management in theWeb Application Development documentation).

4. Compile the JSP project:
■ With IDE (from Eclipse or any other IDE)
■ Without IDE (make.bat)

Note: Whenworkingwith an applicationwhich included space characters in the application
name, you are required to manually change the application name in the web application
(e.g. inGXBasicWebForm.jsp file, or in the Framework Configuration Editor, in theApplica-
tion name parameter).

.NET:

1. It is recommended to convert from .NET project type "Web Project" to "Web Site" as from the
current version ApplinX generates .NET web pages based on the "Web Site" format and file
structure.

2. Upgrade the web application using the ApplinX Web Application Manager in the Designer
(refer to Framework Management in theWeb Application Development documentation).

3. Compile (relevant for .NET "Web Projects" type projects):
■ With IDE (from Visual studio)
■ Without IDE (make.bat)

Note: Whenworkingwith an applicationwhich included space characters in the application
name, you are required to manually change the application name in the web application
(e.g. in GXBasicWebForm.cs/GXBasicWebForm.vb file, or in the Framework Configuration
Editor, in the Application name parameter).
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Installing a Fix using Scripts

Fixes are available for Linux and Windows on the Software AG Empower website. Follow the in-
structions below when downloading the fix from Empower.

Note that when applying a fix, you must make sure that the installed ApplinX version is of the
same service pack as the fix version, i.e. that the first three digits are the same (e.g. 10.1.0).

To install a fix

1 The fix will install and add all the necessary new files to your existing ApplinX installation.

2 Before starting the fix installation, shut down theApplinX Server service and close the Software
AG Designer.

3 To start the fix installation process, extract the fix zip file to the existing ApplinX directory:
For example: C:\SoftwareAG\ApplinX. A new directory is created: \hotfix-<hot fix version>.

4 To install the fix, just run install-hotfix.bat on Windows platforms, or install-hotfix.sh on Linux
platforms. OnWindows platforms: Check that the ECLIPSE_PATH parameter is pointing to the
desired Eclipse installation location and that you have removed the rem remark indication.

Note: Installing the fix also updates the Eclipse plug-in.

5 During the fix installation, a backup folder will be created containing the original files from
before the update (backup-for-hotfix-<hot fix version>).

6 After the fix installation, a log is created with a list of all the copied files (install.hotfix.log).

7 Upgrade the web application using the ApplinX Web Application Manager in the Designer.
Refer to Framework Management in theWeb Application Development documentation.

Note: It is possible to uninstall the fix. This will revert all updated files to their original state.
To uninstall the fix, just run uninstall-hotfix.bat onWindows platforms, or uninstall-hotfix.sh
on Linux platforms. After the fix uninstallation, a log is created with a list of all copied files
(uninstall.hotfix.log).
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Upgrading the ApplinX Server

When upgrading the ApplinX server - for example when applying a fix or during migration - you
will need also to upgrade the web application as well. If the client and server versions do not
match, you will get the following error message:
"Error 6002- Version mismatch.
The application version [<version>] does not match the server version [<version>]. Server version
must be equal to the application version.
Action: Upgrade the web application."

Troubleshooting

■ Upgrading from Version 5.2
■ Converting Old Paths
■ Installing a Fix using Scripts (Hotfix or Fix in Hand)
■ Upgrading a Web Application
■ Use New and Different Workspace for each Environment
■ Uninstalling the ApplinX Server and Designer

Upgrading from Version 5.2

■ GXAR File
If you had trouble migrating from 5.2 or earlier version, you can also upgrade from 5.2 version
by creating a new ApplinX Application (GXAR file) in the new environment and importing the
GXZ file you have exported from the 5.2 version. In this case you can import all the entities
directly to the new application's repository.

■ Binary Client
If you are using a binary client, you will need to re-generate this after migrating from version
5.2.

To re-generate a binary client

■ From the ApplinX Designer, choose Generate Procedure Client on the relevant procedure
group.

See Generating a Procedure Client under Designing and Developing an Application.

The newly generated class files will replace the old class files that are currently included
in your web project.
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Converting Old Paths
ApplinX offers a built-in utility to convert old paths, which are only supported for runtime, into
the new Path Procedures. After conversion, check that all fields weremapped correctly andmatch
the old path in the 5.2 version.

The new Path Procedures are much more powerful. We recommend you convert the old paths to
Path Procedures. See Path Procedures in section Designing and Developing an Application.

Installing a Fix using Scripts (Hotfix or Fix in Hand)

Follow the instructions as described under Installing a Fix using Scripts. Make sure you unzipped
the hotfix into the ApplinX installation directory, otherwise the upgrade process will not work.

Upgrading a Web Application

After applying the hotfix on the ApplinX server and Designer you must also upgrade the web
application as well, otherwise if the client and the server versions do not match, you will get the
following error message: "Error 6002- Versionmismatch. The application version [<version>] does
not match the server version [<version>]. Server version must be equal to the application version.
Action: Upgrade the web application".

See Framework Management in theWeb Application Development documentation.

Use New and Different Workspace for each Environment

When upgrading to a new version it is important to also create and use a different workspace.
After you have created a newworkspace, you can use the workspace import wizard to import the
old workspace configuration to the new one.

Uninstalling the ApplinX Server and Designer

If you want to revert the changes made by the hotfix process and return to your original state, you
can use the uninstall batch file utility to return to the old ApplinX server version and build; the
Designer's plug-in must be uninstalled manually.

To return to original state

1 Close the ApplinX Server and use the uninstall batch file (in Linux it the .sh file) located in
the hotfix directory to remove the fix installed.

Note: If the user has multiple hotfixes, you will need to downgrade the last one first
and then the older one.

2 Open the Designer and chooseHelp > About > Installation Details. Select the ApplinX plug-
in and choose Uninstall.
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3 Reinstall the ApplinX plug-in. Open the Designer and chooseHelp > Install new software.

4 Click Add and select the ApplinX plug-in installation file (located in <Installation direct-
ory>\Software\Designer\updates or <last hotfix folder>\Designer). Thefile naming convention
is:
com.softwareag.applinx.workbench-[version number][XX].[Y].

5 Select the ApplinX plug-in from the list on the Main screen and click Finish.

6 Restart the Designer and open the ApplinX perspective.
After the fix has been uninstalled, a log is created with a list of all copied files (uninstall.hot-
fix.log).

You also need to unzip the old web application file located in the previous version to the location
of the web application folder.
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8 ApplinX Server

The ApplinX server can be started either as a Windows service or using a batch file. ApplinX can
also run under a JavaApplication Server (for further details, refer to the relevant topics inDeploying
with ApplinX in the Designing and Developing an Application documentation).

See also Managing the ApplinX Server in the Administration section.

Windows Service:

In the installation process, it is possible to define that ApplinX server runs as a Windows system
service, started and stopped viaStart > Settings >Control Panel >Administrative Tools > Services.
By default, the service is automatically run when starting the computer.

Batch Files:

ApplinX Server can be run using batch command files, located in the <ApplinX installation>/bin
folder:

Starts the ApplinX server.startup.bat

Stops the ApplinX server.shutdown.bat

Linux Environments:

In the ApplinX installation directory, you can find the following shell scripts:

Starts the ApplinX server.startup.sh

Stops the ApplinX server.shutdown.sh
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Starting the Server Administrator

From the Startmenu, select Software AG > Administration > ApplinX Administration <version
number>.

Alternatively, you can run the Administrator from a remote PC (for example: on a Microsoft
Windows operating system) and connect to the server using TCP/IP.

Logging On

Once you start the ApplinX Administrator, the Logon screen is displayed. When this is the first
time you are logging on, by default, "Administrator" will be displayed in the User name field.
Type the server address (IPv4 and IPv6 address formats are supported) and port. When it is not
the first time you are logging on, the Administrator will automatically try to connect to the last
server it connected to.

You may have to set a new password when connecting for the first time.

Main Screen

The screen consists of four parts:

■ Title bar, menu bar and toolbar.
■ ApplinX Explorer pane.
■ Main view: The main view corresponds to the selected node/entity/session in the ApplinX Ex-
plorer.

■ Status bar: The status bar displays information according to the object selected in themain view.
The status bar may include information such as: the user name, application name, the number
of users connected, indication of file tracing/replaying or the host address.

Operations, features and applications that the logged-in user is not authorized to use will be dis-
abled or are invisible.

■ ApplinX Explorer
■ Toolbar
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■ Menu Bar

ApplinX Explorer

Enables viewing and controlling users' activity, maintaining the server's configuration, viewing
runtime information about connection pools, sessions, server logs, define hosts and design and
configure applications.

The root node.ApplinX

Includes managerial functions.Management

Controls the sessions connected to the server, the server activity and the connection
pools. TheCurrent Activity node is unavailable when the ApplinXAdministrator is not
connected to the server.

Current Activity

Lists the currently connected sessions.Sessions

Provides runtime information regarding the connection pools.Connection Pools

Holds the definitions of the users, their permissions and roles, and the user groups.Security

Lists the server logs.Server Logs

Toolbar

DescriptionIcon

Disconnect from Server

Connect to Server

Server Information...

Server Log

New Folder

New User

New Group

Delete
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DescriptionIcon

Refresh

Up One Level

Menu Bar

File Menu

DescriptionMenu Item

Creates a new user or group.New

Opens the selected item.Open

Deletes the selected item.Delete

Opens the properties of the selected item.Properties

Exits the Administrator.Exit

Edit Menu

DescriptionMenu Item

Selects all entities displayed in the main view.Select All

Selects all entities that were not selected, and deselects entities that were selected.Invert Selection

ViewMenu

DescriptionMenu Item

Hides/shows the ApplinX Explorer tree area of the screen.ApplinX Explorer

Hides/shows the summary area of the screen.Summary

Displays the server log.Server Log

Refreshes the main view to match the data stored on the server.Refresh

Connection Menu

DescriptionMenu Item

Connects and disconnects the Administrator from the server.Connect/Disconnect

Displays the View Sessionwindow of the selected session.Cancel Session
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Tools Menu

DescriptionMenu Item

Displays the Server Information dialog box.Server Info

Displays the User Information dialog box.User Information
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Starting the ApplinX Designer

From theStartmenu, selectAll Programs > SoftwareAG>Tools > SoftwareAGDesigner <version
number>.

Alternatively, you can run the Designer from a remote PC (for example: on a Microsoft Windows
operating system) and connect to the server using TCP/IP. When running the Designer from a re-
mote PC, some Designer features may not work, for example opening the file system.

The first time you start the Designer, a Welcome page will be displayed. From this page you can
access the ApplinX perspective and the help contents. If you close the Welcome page, and you
would like to display the ApplinX perspective, go toWindow > Open Perspective > Other and
select ApplinX.

If you are not yet familiar with Eclipse, see the Eclipse online help at http://www.eclipse.org/doc-
umentation/, or start the Software AG Designer and then chooseHelp > Help Contents. General
information on Eclipse can then be found underWorkbench User Guide. When working with the
Software AG Designer, the online help also provides help for the currently installed Software AG
products; this can be found under Software AG Designer Guides.

Logging on

Once the Designer is displayed, you will see the available list of servers. Double-click on a server
or select Connect from the right-click context menu. When this is the first time you are logging
on, by default, "Administrator" will be displayed in the User name field. When it is not the first
time you are logging on, ApplinX Designer will automatically try to connect to the last server it
connected to.

You can select to remember the user password in the Login dialog box. Once this is selected, the
Login dialog box is not shown again. To require entering a password and displaying the Login
dialog box, change the Remember passwords check box inWindow > Preferences > Software
AG > ApplinX.

Note: The first time theRemember password check box is selected, an Eclipse Secure Storage
message is displayed. Thismessage offers remembering an internal Eclipse password using
a hint, but this is not applicable to the ApplinX server password, therefore clickNo.
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Adding a New Server Connection

Additional connections to servers can be added. To add an additional server connection, in the
Servermenu, selectAdd ApplinX Server Connection.... The wizard is displayed. Enter the name
of the server, the relevant address (IPv4 and IPv6 address formats are supported) and port. Also
determine whether the connection will be a secured connection.

For further details regarding the server configuration, refer to Configuring the Server in the Admin-
istration documentation.

The Designer Layout

■ ApplinX Related Menu Bar Commands
■ ApplinX Explorer
■ Editor
■ Application Map
■ Properties
■ Console
■ Error Log
■ Status Bar

By default the layout is as displayed below, but as possible in Eclipse, the layout can be changed.
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ApplinX Related Menu Bar Commands

Detailed below are the ApplinX related commands that are included in the menu bar.

File Menu

Creates a new ApplinX application.New > ApplinX Application...

Creates a new ApplinX host.New > ApplinX Host...

Creates a new entity from the list of entities.New > Entity

Creates a new display session or printer session (according to the selected
option).

New > Session

Enables importing ApplinX entities or importing/replacing an ApplinX
application.

Import....

Enables exporting ApplinX entities or application.Export...
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Session Menu

Creates another session with the same definitions as the selected session.Duplicate Session
Definition

Connects to the host using the selected session definitions.Connect

Disconnects the session from the host.Disconnect

Opens the session as an instant web application. The session is displayed by
default in the Editor area of Eclipse. It is possible to display the session in your

Open HTTP Session

system's browser by changing theweb browser definitions in Eclipse (Window
> Preferences > General > Web Browser). This is convenient for checking
transformations. This is only availablewhen you have aweb enablement license.

Entity Menu

Displays the WSDL in the Editor area.ShowWSDL

Copies the WSDL URL to the Clipboard.Copy WSDL URL

Displays anHTMLpreviewof the screen.Useful to preview
transformations that are used in this screen.

Open HTML Preview

Generates a JSP page from the current screen.Generate > JSP Page from Screen...

Generates a JSP page from the current screen group.Generate > JSP Page from Screen Group...

Generates a Procedure Client from a procedure group.Generate > Procedure Client...

Generates a JSP page from a procedure.Generate > JSP Page from Procedure...

Converts a screen to a screen group.Convert > Screen to Screen Group

Converts a screen group to a screen.Convert > Screen Group to Screen

Converts a path to a path procedure.Convert > Path / Path Wrapper to Path
Procedure

Application Menu

Opens the application.Open Application

Closes the application.Close Application

Reloads the repository.Reload Application

Imports into the application a list of predefined
transformations.

Import Predefined Transformations

Opens a wizard which enables importing screen maps.Import Host Screen Maps

Displays the Application Map view.Show Application Map

Opens a wizard which enables to automatically identify
screens.

Automatically Identify Screens/Steps using
Trace Files...

Opens a wizard which enables to extract business activities
from trace files.

Extract Business Process Activities

55Getting Started

ApplinX Designer (Software AG Designer)



Initiates theWeb ApplicationManager wizardwhich enables
creating a web application.

Web Application Manager...

Initiates the Deployment Manager wizard which enables
deploying.

Deployment Manager for J2EE...

Opens the file system and allows viewing the files in the
relevant folder.

Open in File System

Server Menu

Adds an additional server connection.Add ApplinX Server Connection...

Connects to the server.Connect to Server

Disconnects from the server.Disconnect from Server

Reloads the server configuration, i.e. the configuration of all applications
connected to the server.

Reload

Displays a list of the available web services.ShowWeb Services

ApplinX Explorer

The ApplinX Explorer is comprised of the ApplinX Explorer toolbar and the ApplinX Explorer
tree.

ApplinX Explorer Toolbar

Adds a new server connection.

Connects to the selected server.

Disconnects from the selected server.

Enables finding an entity.

Enables creating new entities in the currently selected application.

ApplinX Explorer Tree

Local ApplinX server

Hosts

<Host name>

<Application name>

Session (disconnected)

Session (connected)

Printer Session
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Repository

Screen

Screen Group

Transformation

Connection Pool

Connection Information Set

Procedure Group

Flow Procedure

Path Procedure

Program Procedure

Data Structure

Database Connection

External Web Service

Editor

The various entity editors are displayed in the editor area: Screen, Screen Group, Transformation,
Connection Pool, Connection Information Set, Path Procedure, ProcedureGroup, FlowProcedure,
Program Procedure, Data Structure, Database Connection and External Web Service. This area
also displays the HTML preview of a screen, the list of all relevant web services and a specific
WSDL.

Application Map

The Application Map view displays application screens through which the user has navigated.
Refer to Application Map in the Designing and Developing an Application documentation for further
details.

Properties

This area displays basic details regarding the object selected in the ApplinX Explorer tree. For ex-
ample, when selecting the Server, the Properties area displays a number of parameters such as
the server address, port, state and version. Another example is when selecting the Repository, or
a folder within the repository, the Properties area displays parameters such as the application
name, a detailed list of all the entities, and the number of each type of entity.
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Console

This area displays the console messages.

Error Log

This area displays the error log.

Status Bar

Name of GCT trace file/application name.Online/Offline indication

UNKNOWNwhen the screen has not been identified.Screen name

Row and column, and position in the host.Cursor position

Row and column, and position in the host.Mouse position

Starting position of the currently selected area (in host units).Selection start
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11 Creating a New Application

An application is a project which can contain an internal system within an organization, such as
human resources, billing, customer services etc. In this task, youwill create a newApplinX applic-
ation. Every ApplinX application is connected to a host and has a repository containing all the
ApplinX entities. The steps detailed in this task include the basic steps required to create an applic-
ation. Advanced configuration is explained in Application Configuration Parameters in the Reference
Guide.

To create an ApplinX application

Before creating a new application, ensure that ApplinX server is available and running, and start
the Designer. Log in to the relevant server or add an additional server as required (refer to the
sections Logging on and Adding a New Server Connection.

1 In the ApplinX Explorer, right-click on the ApplinX server and selectNew Application... .

Or:

Select the menu item File > New > Other.... In the resulting window, expand the Software
AG node, then the ApplinX node, select Application, and then clickNext.

The Create a New Applicationwizard is displayed.
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2 Enter a name for the application and a suitable description.

3 Select the initialization mode:

Automatic
Automatically loaded when the server is started.

When first accessed
Loaded when first accessed, in other words, when the code that initializes startup is first
called (default).

4 ClickNext.
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Select whether to use an existing host or to create a new host.

Note: SAG_MainFrame is accessible only from within the Software AG network.
Therefore, this host can only be selected when working offline using a trace file.

5 When selecting to define a new host, enter a name for the host and select the relevant type of
host. ClickNext.
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The host connection and conversion parameters are displayed. It is mandatory to enter the
host's name/IP address (IPv4 and IPv6 address formats are supported). Configure the other
parameters as required. Further details of these parameters are available inHost Configuration
Parameters in the Reference Guide.

6 Click Finish. The application is displayed in the ApplinX Explorer. It is possible to further
configure the application properties by right-clicking on the application name and selecting
Properties. Refer to Application Configuration Parameters in the Reference Guide for details re-
garding the advanced configuration properties.

Confirming Connectivity

To confirm connectivity to the host

1 In the ApplinX Explorer, expand the relevant application node.

2 Expand the Sessions node. Right-click onDefault and select Connect. The first host screen
is displayed and the icon of the default session changes to . Navigate between the screens
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to confirm connection and host functionality. If there is a connection problem, check that the
host is working and that the host definitions are correct.

Further information regarding application configuration can be found in Defining Applications in
the Designing and Developing an Application documentation.
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12 Creating an ApplinX Web Application

■ Creating an ApplinX for JSP Web Application using the Software AG Designer (recommended) ...................... 66
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■ Upgrading an ApplinX .NET Web Application to Visual Studio 2015 or 2017 ................................................ 81
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Creating an ApplinX for JSPWebApplication using the Software AGDesigner
(recommended)

The following is based on the released Eclipse version. Additional information can be found on
Eclipse website and WTP (web tool platform) site.

To create a new Dynamic Web project

1 In the Eclipse workspace, select File > New > Project to create a new project.

2 SelectWeb > Dynamic Web Project.

3 ClickNext to create a newwebproject. TheNewDynamicWebProjectdialog box is displayed.
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4 Enter a name for the project.

5 In the Target Runtime field, select the Tomcat installation: clickNew... and select the server
to be used: Either J2EE Preview (recommended) or Tomcat v5.5.

Important: The Restart function in the J2EE Preview server does not work properly. In-
stead of using the Restart function, stop and the start the server. In addition, editing
files only works after stopping and starting the server.
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6 ClickNext.
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7 Browse and select the Tomcat installation.

Note: Currently theApplinX internal Tomcat cannot be used to create aweb application
and when selecting to use Tomcat, you are required to install an additional Tomcat 8.5
version.

8 Select a JRE or click Installed JREs... to add a new JRE. ThePreferencesdialog box is displayed.
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9 Define the Runtime Environment (JRE) for the server: JSP server requires a full JDK and not
only the JRE bundle. If you need to add a new JRE, click the Add... button.
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10 Assign a name to the new JRE.

11 Enter the JRE home directory (when necessary, click Browse... to locate the file).

12 Add VM arguments when required.

13 ClickOK to return to theNewServer Runtimedialog box. Select the newly created JRE. Click
OK.

14 Click Finish. TheNew Dynamic Web Project dialog box is displayed.

You have completed the configuration of the flexible project, the server (Tomcat) and the JDK.

15 Change the configuration to Custom and clickModify.

Select ApplinX Framework. Ensure that the Dynamic Web Module and Java check boxes
are selected. ClickOK.
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16 ClickNext.

17 ClickNext.

18 You have completed the creation of a standard WAR file (Java Web Archive).
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19 ClickNext.

20 Select the type and template of your web application:
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21 Ensure that in the Projectmenu, Build Automatically is selected.

To run the project, right-click on the project's folder in the Project Explorer view and select
Run As > Run on Server....

The first time you run a project you are required to select a default server:

Select the server you configured.

Select the Always use this server when running this project check box. The next time you
run the application, this dialog box will not be displayed. The server you selected will auto-
matically be used.

Click Finish to continue. A browser window will be opened.

Note: The browser type can be configured underWindows > Preferences > General >
Web Browser. It is recommended to configure it toDefault system web browser.
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Using the Javadoc as a reference within the code

When using the Javadoc you will have:

■ Online usage of the Eclipse Javadoc for ApplinX API.
■ Suggested argument names for the ApplinX API, instead of arg0, arg1, etc.

To use Javadoc capabilities when developing your project

1 Right-click on the project node and selectBuild Path >Configure Build Path.... The Properties
dialog box is displayed.

2 In the Libraries tab, expand the gxframework.jar node, click on Javadoc location and then
click on the Edit... button to determine the location of the Javadoc.

3 You can either enter theURL http://localhost:2380/applinx-help or browse and select the Javadoc
location path <Software AG installation> > ApplinX > Help > API. Then clickOK.

4 ClickOK to close the Properties dialog box.

Creating an ApplinX for JSPWeb Application using JDK and Tomcat (no IDE)

Note: This is not available when working with a SOA license.

To create a new JSP application without any IDE and with JDK

Refer to ApplinX for JSP Web Application in Software Requirements.

1 During the installation process, choose the option ApplinX Framework for JSP.

2 In the ApplinX Explorer, right-click on the relevant application and selectWeb Application
Manager.... TheWeb Application Managerwizard is displayed.
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3 Ensure that Create a newWeb application (for IIS or Tomcat) is selected. ClickNext. The
Create a NewWeb Application screen is displayed.

Getting Started76

Creating an ApplinX Web Application



4 Ensure that JSP is selected. Select the application type:New application to create a basic
ApplinXweb applicationwith aweb look and feel orEmulation template to create anApplinX
web application with a host look and feel.

5 ClickNext. The Create a New JSP Web Application screen is displayed.

Enter a name for the web application. By default this is the name of the ApplinX application
that you selected. Browse and select the folder where Tomcat is installed. Select the location
of the JDK installation.

When you wish to use the ApplinX internal Tomcat, select the corresponding check box.

6 ClickNext. TheWizard Summary screen is displayed.

7 Select whether to launch the browser when the process is completed.

8 Select whether to restart Tomcat. This is only relevant when Tomcat is activated from a batch
file. The Framework Manager does not support restarting Tomcat when Tomcat runs as a
Windows Service (in this case, you need to manually restart Tomcat).

9 Click Finish. Amessagewill be displayed indicatingwhether the process succeeded or failed.

Note: Any change in the Java file requires recompilation of your new application. Changes
in JSP files do not require recompilation. Furthermore, Tomcat requires reloading: http://loc-
alhost:8080/manager/reload?path=/<YOUR_APP_NAME>.
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Creating an ApplinX .NET Web Application using Visual Studio 2015 or 2017

To create a new ApplinX web application using Visual Studio 2015 or 2017

1 Install J# 2.0 redistributable package.

2 Install .NET Framework 3.5 SP1.

3 Install Microsoft Visual Studio on your computer (install Visual Studio before installing Ap-
plinX so that when installing ApplinX, the ApplinX web application templates will be added
to the available Visual Studio NewWeb Sites).

4 Open Visual Studio.

5 In the Filemenu, selectNew and thenWeb Site... to create a new web site. TheNewWeb
Site dialog box is displayed.

6 Select to work either with .NET Framework 2.0 or 4.0.

7 Select the relevant ApplinX web application type (Visual C# or Visual Basic).

8 Define that index.aspxwill be the start page (right-click on index.aspx and select Set as Start
Page).

9 Run the web site

10 In the Framework Configuration Editor, define the connection parameters as follows:

1. Click on the Framework Configuration link. The Configuration Editor will be displayed.

2. In the Session node, enter the application name. By default, the application name is "In-
stantDemo". In the Session node, it is possible to edit and configure additional connection
and project properties.

3. Click Save to save your changes.

4. Click Close to return to the web application.

Creating an ApplinX .NET Web Application using .NET (no IDE)

Note: This is not available when working with a SOA license.

To create a new ASP.NET application without Visual Studio .NET with .NET SDK

1 DuringApplinX installation, select theApplinXASP.NETWebFrameworkC#/VB .NEToption.

2 In the ApplinX Explorer, right-click on the relevant application and selectWeb Application
Manager.... TheWeb Application Managerwizard is displayed.
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3 Ensure that Create a newWeb application (for IIS or Tomcat) is selected. ClickNext. The
Create a NewWeb Application screen is displayed.
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4 Ensure thatC# 2.0 orVB 2.0 is selected. Select the application type:New application to create
a basic ApplinX web application with a web look and feel or Emulation template to create
an ApplinX web application with a host look and feel.

5 The Create a New .NET Web Application screen is displayed.

6 Enter a name for the web application. By default, this is the name of the ApplinX application
that you selected. Browse and select the destination folder.

7 ClickNext. TheWizard Summary screen is displayed.

8 Select whether to launch the browser when the process is completed.

9 Click Finish. Amessagewill be displayed indicatingwhether the process succeeded or failed.

Note: When using the Application Manager on IIS 7.5 or 8.0, you need to convert your
application from a virtual directory to aweb application (in the IISmanager, right-click
on your application and select Convert to Application).
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Upgrading an ApplinX .NET Web Application to Visual Studio 2015 or 2017

To upgrade a project to Visual Studio 2015 or 2017

Ensure that you have J# 2.0 redistributable package Second edition installed.

1 In Visual Studio 2015 or 2017, open the web application by clicking File > Open > WebSite...
and selecting the web application.

2 Determine whether you would like to work with .NET 2.0 or .NET 4.0.

3 In ApplinX Designer, upgrade your web application using the ApplinX Web Application
Manager (refer to Upgrading a .NET Web Application inWeb Application Development.

4 Define that index.aspxwill be the start page (right-click on index.aspx and select Set as Start
Page).

5 You can run the web site to ensure that it performs as expected.
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ApplinX provides several demo applications: Instant demo, Composite demo and SOA demo,
based on a typical legacyNaturalmainframe application. These applications contain typical legacy
screens such as update screens, task screens, windows screens and more. The web applications of
the demos contain various examples of common tasks needed to be performed in a typical web
enabling/SOA application (in .NET or JSP). Such examples include external login page, path pro-
cedures, and tables combining a few screens to one.

Note: Whenworking inWindowsOS, by default the repository is loaded from the database
providedwith ApplinX.Whenworking with Linux, the repository of the demo application
is loaded from an external gxz file and therefore changes cannot be made to entities (read-
only).

The Insurance applications (Instant, Composite and SOA)manage customer details and proposals
of a fictitious insurance company. They store and display information about the current customers
and their proposal details. The applications containmodules for updating, deleting, and displaying
customer records and proposals. There are three Insurance based applications:

■ The Instant demo application includes the entities required for an instant web application.
■ The Composite demo application includes, in addition to the entities included in the instant
demo, paths and procedures used in the composite web application.

■ The Service Oriented Architecture (SOA) demo application includes the entities required to
expose Procedure Clients and forms that have been generated.

The ApplinX web demo applications are distributed as part of the ApplinX installation. They
containmany useful examples and code snippets, and therefore it is recommended to install them,
browse through them and inspect their sources.

Installing the Demo Web Application using the Software AG Designer

Refer to Creating an ApplinX Web Application using the Software AG Designer and select the
desired application type.

Installing the Demo Web Application using Tomcat

To install the demo web application

1 Right-click on the relevant application (make sure that it is one of the demo applications: In-
stant, Composite or SOA) and selectWeb Application Manager....

2 Ensure that Create a newWeb application is selected. ClickNext. The Create a NewWeb
Application screen is displayed.
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3 Ensure that JSP is selected as the language.

4 Select the relevant demo name as the Application type. ClickNext.

5 Enter a name for the web application.

6 Browse and select the folder where Tomcat is installed.

7 Select the location of the JDK folder.

8 ClickNext. TheWizard Summary screen is displayed.

9 Select whether to launch the browser when the process is completed.

10 Select whether to restart Tomcat.

11 Click Finish. Amessagewill be displayed indicatingwhether the process succeeded or failed.

Installing the Demo Web Application (Other Java Application Servers)

To install the demo web application

1 Right-click on the relevant application (make sure that it is one of the demo applications: In-
stant, Composite or SOA) and selectDeployment Manager for J2EE....

2 SelectApplinX for JSPWeb application and clickNext. TheSelect ApplinXWebApplication
screen is displayed.

3 Select Project in other location. Browse and select <ApplinX installation>\ApplinX\new
jsp\<demo application name>.

4 Select Include source files to include the Java files as well as the compiled classes. ClickNext.
The Select Package Parameters screen is displayed.

5 Select the Java Application Server, the WAR file name and the destination folder where the
output file will be placed.

6 ClickNext. The Select Target ApplinX Server screen is displayed.

7 Select the name/IP address of the server, the port number and the ApplinX application name.
Click Finish.

8 In the console area, it is possible to see whether the process succeeded or failed. The WAR
file created should be placed in your web server directory.
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Installing the Demo Web Application using Visual Studio

To install the sample application in Visual Studio

1 Open Visual Studio and open a NewWeb Site.

2 In theNewWeb Site dialog box make sure Visual C# is the selected language.

3 Choose one of the following templates:

■ ApplinX C# Composite Demo Application.
■ ApplinX C# Instant Demo Application.
■ ApplinX C# SOA Demo Application.

4 Right-click index.aspx and select Set as Start Page.

5 Click Start to run the project.
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The Instant Demo

■ template.jsp/template.master
■ Screen Name: Login
■ Screen Name: InsuranceMenu
■ Screen Name: BrowseCustomers

Note: When using a replay file, it is possible to navigate from one screen to the next by
pressing ENTER in each web screen. Clicking on buttons which execute paths will work only
if the replay file contains the relevant path navigation recorded and the session screen is in
the relevant starting point to execute the path. If this is not the case, the path will fail and
the user will receive an error from the web application.

When using transformations it is important to notice the order inwhich the transformations appear
in the screen editor (Transformations tab). Transformations can change thewayApplinX perceives
a host screen. If, for example, the first transformation hides a certain text on the screen and the
second transformation searches for that text pattern in order to replace it with a link then the
second transformation will never find a match for that pattern since it has been removed by the
first transformation. So always keep in mind, the order of the transformations in the screen editor
will be the order in which they will be executed.

template.jsp/template.master

Refer to Customizing the Default Template in theWeb Application Development documentation for a
detailed explanation on how to change the default template.

■ The host keys relevant for this screen are displayed on the left of the screen. This is defined in
the template.jsp/template.master (.NETweb apps) file in the host key control. The host key control
displays all the host keys for the current host screen. It is possible to definewhether they should
appear horizontally or vertically , in the form of buttons, links or a pre-defined template (see
"gx:GXHostKeysControl" in .NETweb apps or "gx:hostKeys" tag in JSP applications). The default
host key style is defined in the css/styles_instant.css style sheet in the "gx_hky" class.

■ The Page footer section contains links that performvarious actions such as logging off, refreshing
the page, submitting a terminal key and so on. These links can be defined in the template.jsp/tem-
plate.master file (look for "pgfooter" control in the instant demo app).
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Screen Name: Login

Host Screen
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Screen in Web Application

Note: The sections that are referred to below can be found in the Designing and Developing
an Application documentation.

■ Identify the screen using the "-DEMOCO-" and "COM-PLETE System Logon" texts. Refer to
Define Identifiers.

■ Map theMessage, UserID, Password and Reconnect fields. Refer toMap Fields.
■ The "HideTextTODel" transformation hides text in a defined area. Refer to Transforming a Text
Pattern to Text and select the "Hide" option.

■ The "RemoveDots" transformation removes dots followed by a colon ("...:"). Refer to Transforming
a Text Pattern to Text.

■ The "HideInputField" transformation hides input fields in a defined area. Refer to Transforming
an Input Field to a Text Field and select the "Hide" option.

■ The "HideText" transformation hides text in different areas in the screen. Refer to Transforming
a Text Pattern to Text and select the "Hide" option.
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■ The "DashesToLine" transformation changes all the dashes in the screen to lines. Refer to
Transforming a Repeating Characters Pattern to a Line.

■ The "AddLoginButton" transformation adds a button used to login. Clicking on this button ex-
ecutes the "login" path procedure. Refer to Transforming a Text Pattern to a Button.

The "login" path procedure receives the user ID and password as inputs.
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Screen Name: InsuranceMenu

Host Screen
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Screen in Web Application

Note: The sections that are referred to below can be found in the Designing and Developing
an Application documentation.

■ Identify the screen using the "DEMO" and "DEMOM" texts. Refer to Define Identifiers.
■ Map the Code, Time andMessage fields. Refer toMap Fields.
■ The "CleanMenuScreen" transformation hides text in a number of defined areas in the screen.
Refer to Transforming a Text Pattern to Text and select the "Hide" option.

■ The "AllGroup" screen group includes all the screens that include in row 1, column 23 the content
"*****Demo Insurance Solution*****". The "AllGroup" screen group includes various transform-
ations:
■ Removing the first line in the screen (the "RemoveFirstLine" transformation). Refer to Trans-
forming a Text Pattern to Text and select the "Hide" option.

■ Formatting the screen name (the "FormatScreenNameHeader" transformation).
■ Removing dots that are followed by a colon "...:" (the "RemoveDots" transformation). Refer
to Transforming a Text Pattern to Text.

■ Hiding the time that appears in the top right corner (the "HideText" transformation). Refer
to Transforming a Text Pattern to Text and select the "Hide" option.

■ The "MenusGroup" screen group includes all screens that include text: "code", and text "menu".
This screen group includes a transformationwhich transformsmenus to links (the "MenuToLinks"
transformation). Refer to Transforming a Menu to Hyperlinks.
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■ Associate the "AllGroup" and "MenusGroup" screen groups to this screen.
■ Refer to the template section above to see how to implement placing the host keys on the left of
the screen, and placing buttons in the footer.
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Screen Name: BrowseCustomers

Host Screen
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Screen in Web Application

■ Identify the screen using the "BCUSTBN0" and "BCUSTBN1" texts. Refer to Define Identifiers in
the Designing and Developing an Application documentation.

■ Refer to the Fields tab to see the mapped fields.
■ Refer to the template section above to see how to implement placing the host keys on the left of
the screen, and placing buttons in the footer.

The Composite Demo

■ template.jsp/template.master
■ Screen Name: Login
■ Screen Name: Browse Proposals
■ Screen Name: ModifyProposal1
■ Screen Name: BrowseCustomers1

Note: When using a replay file, it is possible to navigate from one screen to the next by
pressing ENTER in each web screen. Clicking on buttons which execute paths will work only
if the replay file contains the relevant path navigation recorded and the session screen is in
the relevant starting point to execute the path. If this is not the case, the path will fail and
the user will receive an error from the web application.
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template.jsp/template.master

Refer to Customizing the Default Template in theWeb Application Development documentation for a
detailed explanation on how to change the default template.

JSP

In this template we use these panels (that can be overridden by specific pages):

■ CssPanel: holds the css links (has a default in the template).
■ JSPanel: holds the JavaScript code and JavaScript file references.
■ HeaderImagePanel: by design, an image in the top-right corner changes according to the data.
■ MenuPanel: holds the menu that is included in the pages. In some specific pages it is empty,
therefore the menu is not displayed.

■ GXPagePlaceHolder: holds the data for the page.

.NET

In this template we use these panels (that can be overridden by specific pages):

■ CssPanel: holds the css links (has a default in the template).
■ JSPanel: holds the JavaScript code and JavaScript file references.
■ HeaderImagePanel: by design, an image in the top-right corner changes according to the data.
■ MenuPanel: holds the menu that is included in the pages. In some specific pages it is empty,
therefore the menu is not displayed.

■ GXPagePlaceHolder: holds the data for the page.
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Screen Name: Login

Tasks

Refer to the following sections in theWeb Application Development documentation:

■ Building an External Login Page
■ Controlling the Connection Properties from Code
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Screen Name: Browse Proposals

Tasks

Refer to the following sections in theWeb Application Development documentation:

■ Activating an Application Map from a Menu
■ Creating Designed Web Pages
■ Creating a Button / Hyperlink for Submitting a Host Key
■ Using Web Application Controls in Generated Pages
■ Exporting Data to an MS Office Application (Excel, Word)
■ Adding the Sorting Capability to a Screen-Based Table
■ Creating a Page with a Table
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Screen Name: ModifyProposal1

Tasks

Refer to the following sections in theWeb Application Development documentation:

■ Collecting Data from Multiple Host Screens
■ Creating a Button / Hyperlink for Executing a Path Procedure
■ Updating Data in Multiple Host Screens
■ Activating an Application Map from a Menu
■ Creating Designed Web Pages
■ Creating a Button / Hyperlink for Submitting a Host Key
■ Using Web Application Controls in Generated Pages
■ Map Fields (identify dynamic fields by their leading label)
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Screen Name: BrowseCustomers1

Tasks

Refer to the following sections in theWeb Application Development documentation:

■ Activating an Application Map from a Menu
■ Creating Designed Web Pages
■ Collecting Data from Multiple Host Screens
■ Creating a Button / Hyperlink for Submitting a Host Key
■ Using Web Application Controls in Generated Pages
■ Adding the Sorting Capability to a Screen-Based Table
■ Exporting Data to an MS Office Application (Excel, Word)
■ Customizing the Table's Display
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The SOA Demo

.NET and JSP implementation can be done in many ways. This demo includes examples of one
way to implement the tasks. For example, in one of the tasks below,we demonstrate how to display
data collected by the procedure client. To do this we use the framework. In .NET, this can also be
implemented using .NET datagrid.

The following lists the different typical tasks that we have demonstrated in the SOA application
included with the ApplinX installation. Next to each task, the entities involved with this task are
detailed. This enables you to further explore the configuration of each of these entities.

1. Identify and define host screens in the ApplinX repository. Refer to Screens in theDesigning and
Developing an Application documentation.
■ INS_Browse_Customers
■ INS_Customer_Details_1
■ INS_Customer_Details_2
■ INS_Customer_Details_3
■ DEMOCO_Login
■ DEMOCO_Menu
■ DEMOCO_Splash
■ E_Environment
■ INS_Menu

2. Create a connection pool with a connection information set (for offline use). Refer to Connection
Pools andConnection Information Sets in theDesigning andDeveloping anApplicationdocumentation.

a. Set the pool size as required.

b. Set a connection information setwhen required (SOADemo includes connection information
sets that allow the application to run in offline mode).

c. Set navigation rules:

i. Create an initialization path for the pool that initializes each new connection in the pool.
This path should finish in the "Initial screen", otherwise the initialization will fail.

ii. Set the initial screen a connection should wait on.

iii. Create and set a recycle path to recycle connections in the pool.

iv. Create and set a termination path for properly terminating a connection in the pool. For
more information see Defining a Termination Path in the Designing and Developing an Ap-
plication documentation.
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As you may have noticed, the SOADemo repository contains three connection pools. This is
for the sole reason of enabling the application to retrieve results in offline environments (that
do not have connectivity to Software AG's network). All three pools share the same setting
(pool size and navigation settings), but differ in their connection information sets. To enable
offline execution of the application, each procedure has been executed with its own replay file
(set in its connection information set), whereas, online execution requires no replay file at all.

3. Collect data frommultiple screens. Refer to Collecting Data fromMultiple Host Screens in theWeb
Application Development documentation.

a. Create a path procedure which collects table data (refer to the Browse_All_Customers path
procedure). Refer to Creating a Path Procedure in the Designing and Developing an Application
documentation.

i. Assign a connection pool to start from the relevant screen.

ii. Create aWhile loop that checks if an "End of data"message appears on the screen,marking
the table's end.

iii. For every table instance: Collect the tabular host screen data and page down for the next
instance.

b. Create a path procedure which collect data frommultiple screens (refer to the GetCustomer-
ByID path procedure). Refer to Creating a Path Procedure in the Designing and Developing an
Application documentation.

i. Assign a connection pool to start from the relevant screen.

ii. Add an input to allow the user to specify which customer details they wish to retrieve.

iii. Navigate to the Details screens and map host fields to the procedures' output.

c. Assign procedures to procedure groups. Refer to Assigning a Procedure to a Procedure Group
in the Designing and Developing an Application documentation.

d. Generate a procedure client from the procedure group (refer to DemoINS procedure group
in the demo repository). Refer toProcedure Clients in theDesigning andDeveloping anApplication
documentation.

4. Bind web controls to procedure response (output). Refer to Binding Procedure Outputs to an Ap-
plinX Framework Based Web Page in the Designing and Developing an Application documentation.

a. For each procedure, create a JSP/ASPXpagewith controlswhichmatch the procedure output.

b. Fill the form (using gx_fillForm).
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15 Self-Training and Movies

A self-training, basic tutorial of ApplinX and accompanyingmovies can be found on the Software
AG Empower website at https://empower.softwareag.com. After entering your user name and
password, navigate to the ApplinX documentation and click the PDF icon.

In the ApplinX documentation page, choose Product Documentation > Self-Training.
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Starting your ApplinX Server

The ApplinX server can be started either as a Windows service or using a batch file. ApplinX can
also run under a JavaApplication Server (for further details, refer to the relevant topics inDeploying
with ApplinX in the Designing and Developing an Application documentation).

See also Managing the ApplinX Server in the Administration section.

Windows Service

In the installation process, it is possible to define that ApplinX server runs as a Windows system
service, started and stopped viaStart > Settings >Control Panel >Administrative Tools > Services.
By default, the service is automatically run when starting the computer.

Batch Files

ApplinX Server can be run using batch command files, located in the <ApplinX installation>/bin
folder:

Starts the ApplinX server.startup.bat

Stops the ApplinX server.shutdown.bat

Linux Environments

In the ApplinX installation directory, you can find the following shell scripts:

Starts the ApplinX server.startup.sh

Stops the ApplinX server.shutdown.sh

Starting the ApplinX Server Administrator

■ Starting the Server Administrator
■ Logging On
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■ Main Screen

Starting the Server Administrator

From the Startmenu, select Software AG > Administration > ApplinX Administration <version
number>.

Alternatively, you can run the Administrator from a remote PC (for example: on a Microsoft
Windows operating system) and connect to the server using TCP/IP.

Logging On

Once you start the ApplinX Administrator, the Logon screen is displayed. When this is the first
time you are logging on, by default, "Administrator" will be displayed in the User name field.
Type the server address (IPv4 and IPv6 address formats are supported) and port. When it is not
the first time you are logging on, the Administrator will automatically try to connect to the last
server it connected to.

You may have to set a new password when connecting for the first time.

Main Screen

The screen consists of four parts:

■ Title bar, menu bar and toolbar.
■ ApplinX Explorer pane.
■ Main view: The main view corresponds to the selected node/entity/session in the ApplinX Ex-
plorer.

■ Status bar: The status bar displays information according to the object selected in themain view.
The status bar may include information such as: the user name, application name, the number
of users connected, indication of file tracing/replaying or the host address.

Operations, features and applications that the logged-in user is not authorized to use will be dis-
abled or are invisible.

■ ApplinX Explorer
■ Toolbar
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■ Menu Bar

ApplinX Explorer

Enables viewing and controlling users' activity, maintaining the server's configuration, viewing
runtime information about connection pools, sessions, server logs, define hosts and design and
configure applications.

DescriptionNode

The root node.ApplinX

Includes managerial functions.Management

Controls the sessions connected to the server, the server activity and the connection
pools. TheCurrent Activity node is unavailable when the ApplinXAdministrator is not
connected to the server.

Current Activity

Lists the currently connected sessions.Sessions

Provides runtime information regarding the connection pools.Connection Pools

Holds the definitions of the users, their permissions and roles, and the user groups.Security

Lists the server logs.Server Logs

Toolbar

DescriptionIcon

Disconnect from Server

Connect to Server

Server Information...

Server Log

New Folder

New User

New Group
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DescriptionIcon

Delete

Refresh

Up One Level

Menu Bar

DescriptionItemMenu

Creates a new user or group.NewFile

Opens the selected item.Open

Deletes the selected item.Delete

Opens the properties of the selected item.Properties

Exits the Administrator.Exit

Selects all entities displayed in the main view.Select AllEdit

Selects all entities that were not selected, and deselects entities that were
selected.

Invert Selection

Hides/shows the ApplinX Explorer tree area of the screen.ApplinX ExplorerView

Hides/shows the summary area of the screen.Summary

Displays the server log.Server Log

Refreshes the main view to match the data stored on the server.Refresh

Connects and disconnects the Administrator from the server.Connect/DisconnectConnection

Displays the View Sessionwindow of the selected session.Cancel Session

Displays the Server Information dialog box.Server InfoTools

Displays the User Information dialog box.User Information

Starting the ApplinX Designer (Software AG Designer)

■ Introduction
■ Logging On
■ Adding a New Server Connection
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■ Designer Layout

Introduction

From theStartmenu, selectAll Programs > SoftwareAG>Tools > SoftwareAGDesigner <version
number>.

Alternatively, you can run the Designer from a remote PC (for example: on a Microsoft Windows
operating system) and connect to the server using TCP/IP. When running the Designer from a re-
mote PC, some Designer features may not work, for example opening the file system.

The first time you start the Designer, a Welcome page will be displayed. From this page you can
access the ApplinX perspective and the help contents. If you close the Welcome page, and you
would like to display the ApplinX perspective, go toWindow > Open Perspective > Other and
select ApplinX.

If you are not yet familiar with Eclipse, see the Eclipse online help at http://www.eclipse.org/doc-
umentation/, or start the Software AG Designer and then chooseHelp > Help Contents. General
information on Eclipse can then be found underWorkbench User Guide. When working with the
Software AG Designer, the online help also provides help for the currently installed Software AG
products; this can be found under Software AG Designer Guides.

Logging On

Once the Designer is displayed, you will see the available list of servers. Double-click on a server
or select Connect from the right-click context menu. When this is the first time you are logging
on, by default, "Administrator" will be displayed in the User name field. When it is not the first
time you are logging on, ApplinX Designer will automatically try to connect to the last server it
connected to.

You can select to remember the user password in the Login dialog box. Once this is selected, the
Login dialog box is not shown again. To require entering a password and displaying the Login
dialog box, change the Remember passwords check box inWindow > Preferences > Software
AG > ApplinX.

Note: The first time theRemember password check box is selected, an Eclipse Secure Storage
message is displayed. Thismessage offers remembering an internal Eclipse password using
a hint, but this is not applicable to the ApplinX server password, therefore clickNo.
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Adding a New Server Connection

Additional connections to servers can be added. To add an additional server connection, in the
Servermenu, selectAdd ApplinX Server Connection.... The wizard is displayed. Enter the name
of the server, the relevant address (IPv4 and IPv6 address formats are supported) and port. Also
determine whether the connection will be a secured connection.

For more information see Configuring the Server in the Administration documentation.

Designer Layout

■ ApplinX-related Menu Bar Commands
■ ApplinX Explorer
■ Editor
■ Application Map
■ Properties
■ Console
■ Error Log
■ Status Bar

By default the layout is as displayed below, but as possible in Eclipse, the layout can be changed.
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ApplinX-related Menu Bar Commands

Detailed below are the ApplinX-related commands that are included in the menu bar.

DescriptionItemMenu

Creates a new ApplinX application.New > ApplinX Application...File

Creates a new ApplinX host.New > ApplinX Host...

Creates a new entity from the list of entities.New > Entity

Creates a newdisplay session or printer session (according
to the selected option).

New > Session

Enables importingApplinX entities or importing/replacing
an ApplinX application.

Import....

Enables exporting ApplinX entities or application.Export...

Creates another session with the same definitions as the
selected session.

Duplicate Session DefinitionSession

Connects to the host using the selected session definitions.Connect

Disconnects the session from the host.Disconnect
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DescriptionItemMenu

Opens the session as an instant web application. The
session is displayed by default in the Editor area of Eclipse.

Open HTTP Session

It is possible to display the session in your system's
browser by changing the web browser definitions in
Eclipse (Window>Preferences >General >WebBrowser).
This is convenient for checking transformations. This is
only available when you have a web enablement license.

Displays the WSDL in the Editor area.ShowWSDLEntity

Copies the WSDL URL to the Clipboard.Copy WSDL URL

Displays an HTML preview of the screen. Useful to
preview transformations that are used in this screen.

Open HTML Preview

Generates a JSP page from the current screen.Generate > JSP Page from Screen...

Generates a JSP page from the current screen group.Generate > JSP Page from Screen
Group...

Generates a Procedure Client from a procedure group.Generate > Procedure Client...

Generates a JSP page from a procedure.Generate > JSP Page from
Procedure...

Converts a screen to a screen group.Convert > Screen to Screen Group

Converts a screen group to a screen.Convert > Screen Group to Screen

Converts a path to a path procedure.Convert > Path / Path Wrapper to
Path Procedure

Opens the application.Open ApplicationApplication

Closes the application.Close Application

Reloads the repository.Reload Application

Imports into the application a list of predefined
transformations.

Import Predefined Transformations

Opens a wizard which enables importing screen maps.Import Host Screen Maps

Displays the Application Map view.Show Application Map

Opens a wizard which enables to automatically identify
screens.

Automatically Identify Screens/Steps
using Trace Files...

Opens awizardwhich enables to extract business activities
from trace files.

Extract Business Process Activities

Initiates the Web Application Manager wizard which
enables creating a web application.

Web Application Manager...

Initiates the Deployment Manager wizard which enables
deploying.

Deployment Manager for J2EE...

Opens the file system and allows viewing the files in the
relevant folder.

Open in File System

Adds an additional server connection.Add ApplinX Server Connection...Server

Connects to the server.Connect to Server
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DescriptionItemMenu

Disconnects from the server.Disconnect from Server

Reloads the server configuration, i.e. the configuration of
all applications connected to the server.

Reload

Displays a list of the available web services.ShowWeb Services

ApplinX Explorer

The ApplinX Explorer is comprised of the ApplinX Explorer toolbar and the ApplinX Explorer
tree.

ApplinX Explorer Toolbar

Adds a new server connection.

Connects to the selected server.

Disconnects from the selected server.

Enables finding an entity.

Enables creating new entities in the currently selected application.

ApplinX Explorer Tree

Local ApplinX server

Hosts

<Host name>

<Application name>

Session (disconnected)

Session (connected)

Printer Session

Repository

Screen

Screen Group

Transformation

Connection Pool

Connection Information Set

Procedure Group

Flow Procedure

Path Procedure

Program Procedure
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ApplinX Explorer Toolbar

Data Structure

Database Connection

External Web Service

Editor

The various entity editors are displayed in the editor area: Screen, Screen Group, Transformation,
Connection Pool, Connection Information Set, Path Procedure, ProcedureGroup, FlowProcedure,
Program Procedure, Data Structure, Database Connection and External Web Service. This area
also displays the HTML preview of a screen, the list of all relevant web services and a specific
WSDL.

Application Map

The Application Map view displays application screens through which the user has navigated.
Refer to Application Map in the Designing and Developing an Application documentation for further
details.

Properties

This area displays basic details regarding the object selected in the ApplinX Explorer tree. For ex-
ample, when selecting the Server, the Properties area displays a number of parameters such as
the server address, port, state and version. Another example is when selecting the Repository, or
a folder within the repository, the Properties area displays parameters such as the application
name, a detailed list of all the entities, and the number of each type of entity.

Console

This area displays the console messages.

Error Log

This area displays the error log.
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Status Bar

Name of GCT trace file/application name.Online/Offline indication

UNKNOWNwhen the screen has not been identified.Screen name

Row and column, and position in the host.Cursor position

Row and column, and position in the host.Mouse position

Starting position of the currently selected area (in host units).Selection start
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Note: The functionality described herewas formerly deliveredwith the SoftwareAGproduct
Natural Screen Tester. This product has now been integrated into ApplinX.

Before you Begin

Make sure you have the following:

■ License for ApplinX
■ Software AG Designer
■ Local or remote Natural application to test

See Prerequisites for complete list of system prerequisites.

Glossary of Terms

Assertion
An assertion encapsulates some testable logic specified about a target under test. This can be
an attribute-value pair, for example "firstName":"John", or a true-false statment inserted in
a program where the developer always expects a certain condition, for example
"endOfList":"true". Assertions are stored in the generated JSON file.

Configuration File
Each test project has a configuration file in JSON format. This contains default values for the
packages contained in the test project, for example "hostApplication":"my_Mainframe".

Host
The host containing the application you want to test.

Input
Field identified as input fieldwhen the path procedure is recorded, for exampleUser ID. Inputs
are stored in the generated JSON file.

JSON File
In ApplinX, a JSON file (JavaScript Object Notation) is generated by the Generate Unit Test
wizard from the test project. It contains inputs and assertions for the unit test as attribute-value
pairs. You can copy a generated JSON file and change the inputs and assertions. The unit test
is then run multiple times, once for each JSON file.

Path Procedure
A path procedure corresponds to an individual function, for example LoginFlow or GetUser-
ById. It is the result of the recorded screen flow. From a recorded path procedure you can
generate a unit test.
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Unit Test
A unit test is generated from a recorded screen flow, for example LoginFlow. A unit test is
generated as a path procedure to a new test project or added to an existing test project. The
unit test is run from the Java file that is generated in the test project.

Creating your First Unit Test

■ Step 1: Create a New ApplinX Application
■ Step 2: Identify Screens and Fields for your Path Procedure
■ Step 3: Record your Path Procedure
■ Step 4: Generate a Unit Test
■ Step 5: Run the Unit Test

Step 1: Create a New ApplinX Application

To create a new ApplinX application

1 From the Software AG Designer, open the ApplinX development environment.

2 Connect to theApplinX server by double clicking the server icon. A newdialog for credentials
is opened.

3 In the ApplinX perspective, create a new ApplinX application. Select Local ApplinX server,
and from the context menu chooseNew Application.
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4 Enter a name for your new project, a description and specify the initialization mode. Press
Next. See Application Configuration Parameters in the ApplinX Reference Guide.

5 UnderGeneral ApplinX Application Information, specify your Natural host.

Step 2: Identify Screens and Fields for your Path Procedure

To identify screens and fields

■ See Screens in the Designing and Developing a Test Case documentation.

Step 3: Record your Path Procedure

To record your path procedure

1 Under the Sessions folder, double-click the Default session to start the green screen host
session of the ApplinX application. During this session you record the screen flow of the path
procedure.
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2 Record the screen flow that covers the path procedure.

3 During recording, mark the fields you want to include as inputs for your path procedure.

4 During recording, mark the fields you want to include as assertions for your path procedure.

5 Stop the recording.

6 In the Define Path Procedure Name screen, enter a name, description and folder where the
path procedure will be stored.

Step 4: Generate a Unit Test

To generate a unit test

1 Review the path procedure to make sure the inputs and outputs were recorded correctly. You
can also edit or add logic to the recorded path procedure to make it more general or specific
to suit your needs.

2 Select the path procedure and chooseGenerate Unit Test.
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The following artifacts are generated:

■ Java project that includes a Java file containing the executable path procedure
■ JSON configuration file
■ JSON file containing inputs and assertions
■ required binary files that are included in the Java project

SeeWorking with JSON Files andManaging Test Data underDesigning and Developing an Application.

Step 5: Run the Unit Test

To run the unit test

■ From the Java perspective, select the generated Java file. From the context menu choose Run
as > JUnit Test.
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